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Introduction
About DK Multimedia

DK Multimedia titles are available wherever CD-ROMs are sold. New
titles will be available on a regular basis. For more information, 
contact us at DK Multimedia, 9 Henrietta Street, London, WC2E 
8PS.

You may also visit us on the World Wide Web at:

http://www.dk.com

About this Read Me file

The information in this file is designed to address most of the
problems you may encounter when using any multimedia title. If
you are having problems with Eyewitness Photo Gallery, please take
a look at the items listed in the table of contents to see if your 
particular problem is addressed. If you are still having problems, 
please call our technical support number with details of the problem 
including any error messages that were produced and the full 
specification of your computer.

The numbers in London, United Kingdom are:

Telephone: 0171 753 3488
Fax: 0171 753 7575
E-mail: DKMM@DKMM.CO.UK

The numbers in New York, USA are:

Telephone: 1-800 DKMM 575
Fax: 212 213 5240
E-mail: DKMM@phantom.com

To move around this file, press Page Up and Page Down, or click
in the vertical scroll bar. You can print this file by selecting the
Print command from the File menu.



Context-sensitive help on making the best use of all the features 
within Eyewitness Photo Gallery is available once you have started 
the product. Click on the help ‘?’ button in the top, right-hand corner 
of the screen.  (You will also find a reminder of some of the main 
points in this document.)
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1 Setup and Uninstall Notes

1.1 Minimum System Requirements

In order to run Eyewitness Photo Gallery you will require a 



multimedia computer with the following minimum requirements:

A multimedia PC, with 386SX/25MHz or higher microprocessor, 4Mb 
RAM, MPC-compatible CD-ROM drive, mouse, SVGA 256 color 
display, and Microsoft® Windows® version 3.1 or later.

1.2 If Setup Fails with an Error Message

If the Setup program fails with an error message you should ensure 
that no other programs are running while you try to install 
Eyewitness Photo Gallery. You can check this by pressing Ctrl + Esc 
in Windows 3.1/3.11 or by pressing Alt + TAB in Windows 95.

If Setup fails with an error message indicating a 'General Protection 
Fault' or 'Cannot change properties of...' then
you should check whether Norton AntiVirus software, or any other
virus checking software, is installed on your machine. It is
recognized that the presence of Norton AntiVirus, and certain
other virus checking software, causes problems with the
Eyewitness Photo Gallery Setup program. To overcome problems 
with Norton AntiVirus, type the letters 'REM' (followed by a space) at 
the beginning of any lines that have the text 'NAV' in them in the 
‘AUTOEXEC.BAT’ and the ‘CONFIG.SYS’ files. Also, type a 
semicolon ';' at the beginning of the line containing the 'LOAD =' 
entry in the ‘WIN.INI’ file. (The letters 'REM' at the beginning of a line
in the ‘AUTOEXEC.BAT’ and ‘CONFIG.SYS’ files, and the semicolon 
at the beginning of a line in the ‘WIN.INI’ file, cause the line to be 
ignored.) You can edit these files by choosing ‘File’ then ‘Run’ from 
the program manager in Windows 3.1/3.11 or by choosing ‘Run’ from
the ‘Start’ menu in Windows 95. Once you have selected ‘Run’ you 
should type ‘SYSEDIT’ in the text box, and press return. You can 
choose the file you wish to edit from the ‘Window’ drop-down menu. 
Once you have edited the files and saved your changes you should 
exit Windowsâ and restart your computer, then try to run Setup 
again. Similar steps can be taken to overcome problems with other 
virus checking software.

Put these changes back once the Setup program is complete and 
Eyewitness Photo Gallery is successfully installed on your computer. 

1.3 Setup for Windowsâ 95 Users

If you are running Windowsâ 95, Eyewitness Photo Gallery can take 
advantage of Autorun, which should automatically start the 
installation procedure when you insert the disc into your CD-ROM 
drive. Eyewitness Photo Gallery should also run automatically when 



the CD is placed in the CD-ROM drive subsequent to the initial 
Setup. If the installation procedure does not automatically start, or 
the Eyewitness Photo Gallery program does not automatically run 
when the disc is inserted in the CD-ROM drive then you should first 
check that Autorun is enabled. To do this:

1. Go to the 'Start' menu and choose 'Settings', then 'Control
Panel'.

2. Choose 'System' from the 'Control Panel' to bring up a 'System
Properties' window.

3. Choose the 'Devices Manager' tab, and select your particular
CD-ROM drive from the CD-ROM device list.

4. Click the 'Settings' tab in this window, and ensure that 'Auto
Insert Notification' is checked.

If ‘Auto Insert Notification’ is checked, and Setup does not start 
automatically the first time you insert the Eyewitness Photo Gallery 
CD in the drive then you can start the Setup program manually. To do
this, go to the 'Task Bar' and click on 'Start', then 'Run'. Type 'D:\
SETUP' in the text box (where D is the letter of your CD-ROM drive). 
Click 'OK' and then follow the instructions that appear on your 
screen. On subsequent occasions the Eyewitness Photo Gallery 
program can also be run from the Start Menu by selecting 
‘Programs’, then ‘DK Multimedia’, then by selecting Eyewitness 
Photo Gallery. You should also contact your CD-ROM drive 
manufacturer for the latest drivers.

1.4 Running Eyewitness Photo Gallery with Windowsâ 
95

1.4.1 The Task Bar

The ‘Task Bar’ at the bottom of the screen in Windows 95 can force 
Eyewitness Photo Gallery off the top of the screen, meaning that not 
all of the Eyewitness Photo Gallery screen is visible. This happens 
because Windows 95 tells all programs the screen is actually smaller
than it is, so that they do not cover the ‘Task Bar’. The full 
Eyewitness Photo Gallery screen may be viewed by selecting the top
edge of the ‘Task Bar’ with the left mouse button and dragging it 
down and out of sight before running Eyewitness Photo Gallery. 
Alternatively, right-click on an empty area of the ‘Task Bar’, then click
on 'Properties' using the left-hand mouse button and turn on the 



'Auto Hide' option.

Changing to a higher screen resolution will also solve this problem.

1.4.2 Media Player errors

Eyewitness Photo Gallery will work with Windows 95, however, the 
Setup program will try to update the Registration database for Media 
Player (MPLAYER.EXE) and its help file (MPLAYER.HLP). This 
causes Windows 95 to report the following error when you run Media
Player:

"Media Player settings have been changed by another program.
As a result, Media Player will not work correctly.

To fix this problem, click Yes. To exit without fixing this problem,
click No."

You should simply click 'YES' to solve this problem.

1.5 Uninstall

The Eyewitness Photo Gallery CD-ROM contains an Uninstall 
program which is automatically installed in the DK Multimedia 
program group on your computer. If you decide that you no longer 
wish to have Eyewitness Photo Gallery on your computer, you can 
use Uninstall to remove it. Simply double-click on the 'Uninstall' icon 
to display a list of titles on your computer which can be uninstalled. 
Highlight the titles you wish to uninstall, then click the 'Delete' button.
Uninstall does the rest for you!

2 Screen Display Notes

2.1 Screen Resolution

DK Multimedia products have been designed to
look their best with a screen resolution of 640 x 480 pixels. All
screen images are created in this size, and will completely fill the
screen at this resolution. This means that running your screen at a 
higher resolution (such as 1024 x 768) will result in a smaller
image of Eyewitness Photo Gallery being displayed. (It is NOT 
possible to maximize the product to fill screens with a resolution 
higher than 640 x 480.)



2.2 256 Colors

Eyewitness Photo Gallery uses 256 color screen images and we 
recommend that you set your display driver to 256 color mode or 
more. Windows 3.1 and 3.11 users can run the Windows Setup 
program from the Main program group to identify your current driver 
display setting, and if necessary, to change your display driver. 
Windows 95 users can do this by choosing ‘Settings’ from the ‘Start’ 
menu, then choose ‘Control Panel’. Double-click on the ‘Display’ 
icon, then click on the ‘Settings’ tab. Check the amount of colors your
display is using in the ‘Color Palette’ scroll bar. 

If, for any reason, you select an incorrect or unsupported driver:

Windows 3.1/3.11 users
Go to the system prompt and change directory to your Windows 
directory by typing 'C:', then press 'ENTER'. Now type 'CD C:\ 
WINDOWS'. Press 'ENTER' again, then type 'SETUP'. You can now 
reinstall your original driver.

Windows 95 users
Start Windows in ‘Safe mode’. Do this by holding down the F8 key 
when the ‘Starting Windows 95’ message appears on the screen. 
Choose ‘Safe mode’ from the menu. You can now reinstall your 
original driver.

2.3 16 Colors

If your computer is running in 16 color mode, and your display card 
supports 256 colors, you should change to 256 colors or more. This 
will enhance the image quality of Eyewitness Photo Gallery which is 
designed to look its best in 256 colors. Instructions are given below 
for Windows 95 users, and for Windows 3.1 and 3.11 users with 
Cirrus Logic and Diamond Stealth display adapter cards, explaining 
how to change to 256 colors, or more if you wish. (Please note that 
changing to more than 256 colors will not enhance the image quality 
of Photo Gallery. ) All other users should refer to their display adapter
card documentation to do this.

2.3.1 Windows 95 users:

1. From the ‘Start’ menu, choose ‘Settings’ and then ‘Control Panel’.
2. Double-click on the ‘Display’ icon. A ‘Display Properties’ dialog box

will appear.
3. Click on the ‘Settings’ tab.
4. Make sure that under ‘Desktop Area’, the figures below the slider 



control say ‘640 x 480 pixels’. If this is not the case, move the 
slider until ‘640 x 480 pixels’ is displayed.

5. Under ‘Color Palette’, choose ‘256 colors’ (8 bit), or ‘High Color’ 
(16 bit). 

2.3.2 Windows 3.1 and 3.11 users with Cirrus Logic cards:

1. In Program Manager, double-click on the ‘VGA Utilities’ icon.

2. A ‘VGA Utilities’ program group should appear. It will contain either
a ‘SetRes’ icon or a ‘WinMode Utility’ icon, depending on the type 
of Cirrus Logic card you have. Double-click on this icon. If you do 
not have a ‘VGA Utilities’ icon then you should look for either a 
‘SetRes’ or ‘WinMode’ icon.

3. Select ‘640 x 480’ from the list of available screen resolutions.

4. Select ‘256’ (8 bit) from the list of colors available. 

2.3.3 Windows 3.1 and 3.11 users with Diamond Stealth cards:

1. In Windows Program Manager, double click ‘Windows
Control Panel’ in the Main program group.

2. Double click the ‘InControl Tools’ Diamond icon.

3. Select the ‘Display’ button to see options for color depth, and
select ‘256’ color mode.

2.4 Images Appear In Monochrome

Some color display cards may display Eyewitness Photo Gallery 
images in black and white. If this happens, you should upgrade your 
color display driver. Contact the supplier or manufacturer of your 
display card to check that you have the latest display drivers.

2.5 Images are truncated

Some display drivers are designed to provide large fonts. If your 
system is using one of these, any image in the main window will 
appear slightly truncated. You can run the Windows Setup program 
to change the default display driver to one that does not default to 
large fonts.

2.6 ATI cards



Some of the advanced features of ATI cards may be incompatible 
with Eyewitness Photo Gallery. In particular, for the more powerful 
ATI cards, you may find that the ‘256-color palette’ of the ‘ATI Control
Panel’ must be set to ‘ON’. For more information, see your display 
card documentation.

2.7 Saving Images in JPEG format

JPEG is a lossy form of compression. Saving images in this format may 
cause a reduction in the image quality. If your monitor is set to
8-bit color you may see speckles on the image background. Depending on 
your graphics card, you may be able to change the settings by opening the
Desktop Display control in the Control Panels. Should you be unable to 
change your monitor setting, save the image in another format. This problem 
is specific to JPEG and is not present in other formats.

3 CD-ROM Problems

3.1 Care of Compact Discs

Contrary to early reports, compact discs (CDs) are very easily damaged if treated
carelessly. Such damage has a much greater effect on the digital data of a CD-
ROM than on the information of a music CD. A dirty or damaged CD-ROM is 
quite likely to malfunction. With CD-ROM drives becoming ever faster and more 
disc sensitive, this is becoming an increasing problem.

The surface of the disc can quickly gather dirt and is very easily scratched. To 
protect the data from scratches, finger-prints, dust particles, and smears, do not 
touch the readout side (unlabeled side) of the disc or place it face down on a 
hard surface.

Should the CD become dirty, clean it with a soft cloth lightly moistened with CD 
cleaning fluid or ethyl alcohol, working from the center to the edge. Do not use 
any type of solvent, such as benzine, lacquer thinner, anti-static agents or LP 
record cleaners as they may damage the surface.

Never leave the disc in a place subject to direct sunlight, high temperature or 
high humidity. Recommended storage conditions are:

· Temperature: 10ºC to 50ºC (50ºF to 122ºF)
· Humidity: 10 percent to 80 percent

3.2 Problems With CD-ROM Drives



If Eyewitness Photo Gallery has problems finding the data files it 
needs from its CD-ROM, you will see a message asking you to 
select the drive that contains the files. To find what has caused the 
problem, do the following:

1. Check that the Eyewitness Photo Gallery CD has been correctly 
inserted into the CD-ROM drive.

2. Check that Eyewitness Photo Gallery is looking in the right place 
for the CD-ROM Drive. If, for example, the drive letter has changed 
as a result of a system change, such as adding or removing a RAM 
Disk or another device, then Eyewitness Photo Gallery will fail to find
its CD-ROM drive. You can check that the drive letter is correct by 
using Windows File Manager to see which letter is assigned to the 
CD-ROM drive.

3. If you have an external CD-ROM drive, ensure that it is plugged in,
turned on, and connected to your computer. You may need to check 
the documentation that came with the drive.

4. Verify that your CD-ROM drive is MPC-compatible.

4 Running Out Of Memory Or Running Slowly

Eyewitness Photo Gallery uses your computer's system memory to 
display pictures. If you find that Eyewitness Photo Gallery runs 
slowly, or if you come across out-of-memory errors, the program 
probably does not have enough memory. Consider doing the 
following to improve your computer's performance:

1. Close any unnecessary applications, including any DOS
Terminate and Stay Resident programs (TSR's) you may have
installed.

2. Check that your computer has at least 4Mb of memory. You can do
this by leaving Windows, and typing 'MEM' at the system
prompt. Look for total memory in the Total column. If the figure
reads 4096Kb or more, then you have at least 4Mb of memory. If
you have less than 4Mb (minimum 4096Kb) of memory, then you
need to install some more.

3. Check that Windows has sufficient memory available for
Eyewitness Photo Gallery. You can do this by selecting 'About 
Program Manager' from the 'Help' menu in Program Manager. If you 



are running Eyewitness Photo Gallery under Windows 95 you can do
this by double clicking on the 'My Computer' icon, then select 'Help', 
and then select 'About Windows 95'. The memory available should 
be a least 8,192Kb (don't be confused by looking for more memory in
this step than you did in step 3 above. The extra memory here 
indicates the presence of a Windows swap file). You may find more 
memory becomes available if you restart Windows. If the figure is 
less than 8,192Kb this indicates that either you have no Windows 
swap file or that the swap file is too small. If this is the case, you 
should follow step 5 below.

4. If you are running Windows in Enhanced mode, set up a
permanent Windows swap file on your hard disk of at least
4,000Kb. You can do this by following the instructions in your
Windows documentation.

5. If you are running in color modes higher than 256-colors (8 bit), 
you should set your color mode to 256 colors. Refer to ‘Using more 
than 256 colors‘ in section 2, ‘Screen Display Notes’, for instructions 
on changing the color mode.

6. On machines with only 4Mb of memory, restrict the SMARTDRV 
setting that controls the size of the disk cache for use inside 
Windows to 512K or less. If you are running Windows for 
Workgroups 3.11 and using 32-bit disk access, make sure that the 
SMARTDRV settings in your AUTOEXEC.BAT file enable
SMARTDRV to cache your CD-ROM drive efficiently. Consult your 
Windows documentation for further information on how to check and 
adjust these settings.

7. If you are running DOS 6.0 or higher, then you can run the
MEMMAKER utility to optimize the memory in your computer. (For 
example, if you answer 'No' to the question 'Do you use any
programs that need Expanded Memory?', MEMMAKER will free
further conventional memory by inserting the switch NOEMS in
the appropriate line in your PC's CONFIG.SYS file.) Consult your
Windows documentation for further information on using
MEMMAKER.

8. Speed up your hard disk by defragmenting it. There are a
number of tools available to carry out this task, including the
'DEFRAG' command found in MS-DOS version 6.0 and later.

9. Check that 'MSCDEX' which appears in the 'AUTOEXEC.BAT’ file 
is version 2.23 or later, and appears before the 'SMARTDRV' entry. 
You can do this by typing 'MSCDEX' at the system prompt in MS-



DOS. If no version number is given, then you can be sure that your 
version of 'MSCDEX' is older than version 2.23. Versions of 
'MSCDEX' older than 2.23 should be upgraded.

10. The High Quality images are just that - High Quality! They are 
2048 x 2048 pixels, 24-bit color at 300dpi! Uncompressed, they 
can be up to 15Mb each. Thus saving off these images on low-spec 
machines can take quite a while. On low-spec machines we 
recommend using the Large size  (460 x 460 pixels, 8 bit color 
at 72dpi).

5 Printing

Printing screens from Eyewitness Photo Gallery may take several 
minutes, depending on the type of printer you use. Since screen 
resolution and printer resolution are often different, the printout may 
not match the quality you see on the screen. 

If you are not happy with the position on the page or the size of your 
print out, try using the copy function to copy and paste the picture 
into another application such as a word processor or paint package, 
before printing.

You can change the settings of your printer from within Eyewitness 
Photo Gallery by clicking on the image you wish to print, and then by 
clicking on ‘Print Now’.  Once you have selected your chosen printing
options, and clicked ‘OK’, the Print Setup dialog box will appear. 
(Please note: an explanation of the Print Setup dialog box is 
available in your Windows documentation.)

Some dot-matrix printers may not print pictures properly with the 
‘Low / Faster’ quality setting in the ‘Print Setup’ dialog box. On these 
printers change the quality setting in the Printer Settings... dialog box
to ‘High / Slower’.

Because the pictures can be quite large, you may have difficulty 
copying or printing in low-memory conditions. In this case, follow the 
advice in section 4 of this file, and try again.

If any of the following printing problems occur:

- Nothing happens after the ‘Printing’ message
- Corrupt output
- Blank paper output



the following steps should be taken, in the order given. Stop when 
your problem is solved.

1. Try printing from a different application to see if all printing is 
affected. Also make sure that you have the correct driver - you 
should contact your printer manufacturer or vendor to check this.

2. Try different modes of printing, for example, different print quality 
such as draft, fine, line art. The options available will vary 
depending on the type of printer (check your printer Setup 
documentation for information on how to do this).

3. Change the color depth used by the screen driver to 256-colors or 
more. Instructions for some driver types are given in section 2.

4. Ensure that ‘TEMP’ is set in the ‘AUTOEXEC.BAT’ file to a valid 
directory, for example, a line in the ‘AUTOEXEC.BAT’ could say 
‘SET TEMP=C:\WINDOWS\TEMP’. This directory must exist and 
there must be room on your hard disk for this ‘temp’ file to be 
created.

5. Check your hard disk with the ‘Scandisk’ program, provided with 
DOS, and choose to repair all errors it flags. Then re-install the 
printer driver. Windows 3.1/3.11 users should type in ‘SCANDISK’ 
at the DOS prompt. Windows 95 users should choose ‘Programs’ 
from the ‘Start’ button in the ‘Task Bar’. From ‘Programs’, choose 
‘Accessories’, then ‘System Tools’. The Scandisk program can be 
run from here.

6. Obtain the most up-to-date printer driver available. Contact your 
printer supplier/manufacturer to do this.

7. Try another compatible printer driver.
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